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PREFACE

Welcome to the Oracle Insurance Insbridge Rating and Underwriting IBRU Upgrade Guide. The Insbridge
Rating and Underwriting (IBRU) System is a browser-based, multiplatform insurance rating and
underwriting technology solution that provides integrated management for every aspect of the rate
definition and modification process. This guide helps with the upgrading of the Insbridge Rating and
Underwriting System.
There are different types of upgrades available to the 4.6.1 release of the IBRU system:

o RateManager/IBFA

e SoftRater for Windows

o SoftRater for WebLogic

o SoftRater for WebSphere

o SoftRater for JBoss
This document focuses on upgrading RateManager/IBFA and SoftRater for Windows. Also included are

the steps for upgrading SoftRater for WebLogic, WebSphere and JBoss. Detailed instructions for these
upgrades can be found in the corresponding installation guide.

AUDIENCE

This guide is intended for system administrators, installers, database administrators and others tasked
with installing and configuring the IBRU system and associated databases.

TYPES OF INSTALLATION

There are various types of installations:

RateManager Installation

o Full RateManager — This installation installs RateManager and the Insbridge Framework
Administrator (IBFA). This is for a Windows only environment using a SQL Server database.

SoftRater Installation

o Full SoftRater for Java Installation — This installation deploys SoftRater to an application
server; WebLogic, WebSphere or JBoss, using a SQL Server database or an Oracle database.
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o Full SoftRater for Windows Node — This installation is for existing environments that want to
add a SoftRater for Windows node to an environment. This is for a Windows only environment
using a SQL Server database, or an Oracle database.

Upgrading a Current Installation

o Upgrade — This installation is for existing customers and will take their current version of IBRU up
to version 04.06.01.

This guide will describe Upgrading an existing environment.

Definitions

Some commonly used terms when installing or using the Oracle Insurance Insbridge Rating and
Underwriting system:

e IBRU - Insbridge Rating and Underwriting System. This is the entire system.

e IBFA - Insbridge Framework Administrator. IBFA is an administrative tool used to configure
Insbridge applications and setup RateManager database connections. IBFA will be located on a
Windows Server machine. IBFA/SR-WIN is an Insbridge Framework Administrator/SoftRater for
Windows.

e IBSS - Insbridge SoftRater Server. IBSS is the administrative tool for the SoftRater engine. The
SoftRater engine is a multi-platform component within IBRU that executes the rules, rating and
underwriting instructions as defined by the user in RateManager. IBSS is usually located on a
Java machine. IBSS/SR-JAVA is an Insbridge SoftRater Server/SoftRater for Java.

o SoftRater Node — A SoftRater node is either an IBFA (without RateManager) or IBSS instance
on a physical environment.

o SoftRater Native — SoftRater Native is a remote instance of SoftRater that can execute rules and
rating logic in environments where access via the SoftRater web-services is not desired or
possible.

o RM — RateManager. RateManager is a component within IBRU that enables users to manage the
product definition and modification process, including rating and underwriting logic.

e SR - SoftRater. The engine that executes the rating, rules and underwriting instructions defined
within RateManager. The rating environment for runtime execution and processing of business
content. SoftRater can be further defined by the operating system where it has been loaded.

o SR-WIN — SoftRater for Windows. This is also another name for IBFA.

e SR-JAVA - SoftRater for Java. This is also another name for IBSS.

o SRP - SoftRater Packages. A package that holds all the RateManager logic for a specific
program and version.

e VFS - Virtual File Servers. Virtual file server management allows you to access environments
that are located on other machines in different locations where packages can be downloaded.
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Package Location — A pointer to a location where SoftRater Packages (SRP’s) are stored.
Physical Environment — A physical environment is generally referred to as a physical machine.
Authoring Environment — The physical machine where RateManager is installed.

Rating Environment — The physical machine(s) where SoftRater is installed. This is typically the
same as a SoftRater node.

Logical Environment — An environment created for a subscriber in IBFA. It defines package
location, engine location and database location in addition to several other supporting data items.
This environment is used for rating and/or SRP management. Each database connection will
have a logical environment.

Related Documents

For more information, refer to the following Oracle resources:

The Oracle Insurance Insbridge Rating and Underwriting Operating Environments for Hardware
and Software.

You can view this guide on-line at this address:

http://www.oracle.com/technetwork/documentation/insurance-097481.html

Manual History

New editions incorporate any updates issued since the previous edition.

Publication Product

Edition ; Publication Date Comment
Number Version
~1% Edition P01-788-01 May 2011 Initial Release
2" Editon  P01-788-02 R 4.5.1 September 2011  Update
3“Edition  P01-788-03 R 4.6 May 2012 Update
4" Editon  P01-788-04 R 4.6.1 November 2012  Update
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Chapter 1

SYSTEM UPGRADE REQUIREMENTS

Prior to upgrading an IBRU system, please have ready:

OR

The Insbridge User Account information.
The location of the current IBRU installation.
Prior to running an IBRU upgrade, please make sure all users are logged off.

The Insbridge User has administrative rights or proper permissions to run an installation and start
the Insbridge Message Service and the Insbridge Task Manager Service.

You must run as Administrator for a Windows 2008 Server upgrade.

Administrator User name and password for RateManager.

Access to the IBRU databases. Updates are run against the IBRM and the IB_CLIENT
databases. SoftRater databases may not require an update.

NOTE:

Upgrades are performed the same way for either a 32-bit machine or a 64-bit machine. The same
permissions and requirements are needed and should already be set up.

NOTE:

If you attempting to update from a 32-bit Insbridge instance to a 64-bit Insbridge instance, please
contact Oracle Support.

Oracle Software Delivery Cloud

Prior to installation, please make sure the source machine(s) where IBRU will be loaded has an unzip
utility. An unzip utility for most platforms is available on the Oracle Software Delivery Cloud download

page.

Documentation from Oracle Software Delivery Cloud is in PDF format. Prior to installation, please make
sure the source machine(s) where IBRU documentation will be loaded has a PDF reader.

Files are downloaded with part numbers as file names. Please make note of the part numbers you have
downloaded and the corresponding file name. You may be asked to provide the part numbers or the
filename if you contact Oracle Insurance Support.

The installation downloads you can select are:

Insbridge IBRU Install — This is required for all RateManager installations

SoftRater for WebSphere — This is required if you are using WebSphere
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o SoftRater for WebLogic — This is required if you are using WebLogic

o SoftRater for Jboss — This is required if you are using Jboss

e Documentation — It is recommended that you download the documentation. Installation guides

and user guides are located here.

The 04.06.01-Insbridge-IBRU folder contents:

- Databases
¢+ DB2
- SoftRater — IBSR
o DDL
¢ Oracle
- SoftRater — IBSR
o DDL
o Update:Usp_IBSR_v04.05.000racle
¢ SQL Server
- RateManager — IBRM
0 Latinl_General_BIN

= DATABASE_BACKUP_IBRM_TEMPLATE_CASE_SENSITIVE.bak

0 SQL Latinl_General_CP1_CI_AS
= DATABASE_BACKUP_IBRM_TEMPLATE.bak
- Security — IB_CLIENT
0 SQL_Latinl_General CP1_CI_AS
= DATABASE_BACKUP_IB_CLIENT_TEMPLATE.bak
- SoftRater — IBSR
0 Latinl_General_BIN

= DATABASE_BACKUP_IBSR_TEMPLATE_CASE_SENSITIVE.bak

0 SQL_Latinl_General_CP1_CI_AS
= DATABASE_BACKUP_IBSR_TEMPLATE.bak
o Update:Usp_IBSR_v04.05.01.sql

- |E7_IE8 Users
¢ Insbridge IE7 Active X Control Update PDF
¢ RateManager_|E7_IE8.exe

- Oracle Bl Publisher
¢ OBI_PUBLISHER.exe

- Oracle Client
¢ Oracle_client.exe

- Oracle Insurance — Insbridge Rating and Underwriting.exe

No license file is required.

SoftRater can be installed any time after the Insbridge Framework Administrator and RateManager have
been installed. SoftRater must be installed prior to any users creating packages. Please note, all folders

and files may not be needed, depending upon the kind of setup you want.
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Quick View

UPGRADING RATEMANAGER, IBFA AND SR-WIN

Windows should be up and running prior to upgrading. Make sure all users have logged off the system.

Steps to Upgrade RateManager/IBFA:

Every upgrade will require:

e Step 1: Shut Down the Component Services (Com +)

e Step 2: Run the IBRU exe. This will update the application.

e Step 3: Start Insbridge Message Service.

e Step 4: Login to RateManager and perform IBRU database updates.

NOTE: Updates can be performed manually, if desired. Manual updates are performed directly in SQL Server.

This will take RateManager and the corresponding IBFA from 4.0 or later to release 4.6.1.

Additional Steps to Upgrade RateManager/IBFA
You will need to run this step if you are currently running release 3.13.7 or previous:
This procedure takes RateManager and the corresponding IBFA from 3.13.7 or previous to release 4.6.1
and make sure that previous workfiles are available.
e Step 1: Migrate Workfiles.

e Step 2: Update Preferences. Make any updates to Preferences at this time.

Steps to Upgrade SoftRater for Windows from a Previous Release
This procedure takes a SoftRater for Windows node from a previous version to release 4.6.1. This setup
must utilize SQL Server.

e Step 1. Shut Down the Component Services (Com +)

e Step 2: Run the IBRU exe. This will update the application.

e Step 3: Start Insbridge Message Service.

e Step 4: Run the SQL script Usp_IBSR_v04.05.01.sq|, located in the IBRU
download->Database->SQL Server->SoftRater file. This script will need to be run manually by
the DBA.

o If you updating from release 4.5.1, you do not need to run the update script.

11



Chapter 2

UPDATING AN INSBRIDGE APPLICATION

Every upgrade requires:

e Step 1: Shut down the Insbridge Component Services (Com +)

e Step 2: Run the IBRU exe. This updates the application.

e Step 3: Start Insbridge Message Service.

e Step 4: Login to RateManager and perform IBRU database updates.

NOTE: Updates can be performed manually, if desired. Manual updates are performed directly in SQL Server.

This procedure takes RateManager and the corresponding IBFA from 4.0 or later to release 4.6.1.

STEP 1 — SHUT DOWN THE INSBRIDGE COMPONENT SERVICES (COM +)

The Insbridge Com + services need to be shut down prior to the installation. Insbridge Com + uses files
that need to be updated. If Insbridge Com + is running, these files may not be updated. If the Insbridge
Com + services are running, you will receive a message that the system will need to be rebooted after the
installation. Rebooting may not allow for file updates to be performed. To assure that all files are properly
updated, please shut down the Insbridge Com + services.

On the machine where Insbridge is installed, shut down the 3 Insbridge Com + services.

e Insbridge Com+ Administrator 3.5
¢ Insbridge Com+ SoftRater Engine
¢ Insbridge Com+ SoftRater Library

Failure to Shut Down Com + Services

Failure to shut down Com + Services may result in a configured identity error message when accessing
RateManager. To correct, enter the server where the IBRU System was installed. Run the IBRU
executable to remove. Shut down the Com + services. Rerun the IBRU executable again. Enter Com +
and verify the Identity of each of the Insbridge Com + Services is the Insbridge user. The Identity can be
found on Properties->Identity.

1. Click Start>Administrative Tools=>Component Services.

2. Expand the Component Services option under console Root.

3. Expand Computers=>My Computer=>COM+ Applications.

4. Select each Insbridge COM+ library and right click.

12
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5. Select Shut down.

Component Services
A File  Action  Miew  ‘Window  Help |_|ﬂ|i|

€[ ?mIXE o = 0P =E

[ Consale Roat ? % ? % Actions
[ W#e Component Services b - COM+ Applications "

Bl [ Computers COM+ COM+QC  COM+ Ukiities | Insbridge
B2 s My Computer Explorer Dead Let.., Cam+ Ad... More Actions 4
= COM+ Applications
fg’ COM+ Explorer % _% @
2 COM4+ QC Dead Letter Queue Listener L+
= COM+ Utilities Inshridge Insbridge Syskem
‘g‘ Insbridge Com+ Administrator 3.5 Corn+ ... Comn+ ... Application

‘g‘ Insbridge Com+ SoftRater Engine
£ Insbridge Com+ SoftRater Library
& System Application
| DCOM Config
| Running Processes
| Distributed Transaction Caordinatar
@ Event Wiewer (Local)
m, Services (Local)

Figure 1 Component Services

NOTE: The Insbridge Com plus services will be started when users access the system.
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STEP 2 — RUNNING THE IBRU APPLICATION

An update to the IBRU system is run from the Oracle Insurance — Insbridge Rating and
Underwriting.exe. Unzip the IBRU folder on the machine where the IBRU system (IBFA and
RateManager) is currently installed.

1. Begin with the Oracle Insurance - Insbridge Rating and Underwriting Install file.

2. Open the Oracle Insurance — Insbridge Rating and Underwriting file. A Welcome screen is displayed.

i'él Oracle Insurance - Insbridge Rating and Underwriting 04.06.01 Setup M =] |

4 Oracle Insurance Insbridge Rating and Underwriting

[t iz strongly recommended that vou exit all Windows programs before running this setup program.

Click Cancel to quit the setup program, then cloze any programs you have running,  Click Hest to
continue the installation,

WwiARMIMG: Thiz program iz protected by copyright law and international treaties.

IInauthorized reproduction or digtribution of this program, or ang portion of i, may result in zevere civil
and criminal penalties, and will be prozecuted to the masimum exstent pozsible under law.

ORACLE

INSURANCE

Cancel |

¢ Back

Figure 2 Installing Insbridge

3. Click on Next to continue.

14
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i'él‘ Oracle Insurance - Insbridge Rating and Underwriting 04.06.01 Setup =] |

Destination Folder ORACLE

Select a folder where the application will be installed. INSURANCE

The “Wize |natallation ‘wizard will install the files for Oracle Insurance - Insbridge Fating
and Undenariting in the following folder.

Toinztall into a different folder, click the Browse button, and select another folder.
f'ou can chooze not ko install Oracle Insurance - Insbridge B ating and Undensariting by
clicking Cancel to exit the YWize [netallation ‘wizard.

Destination Faolder
’VI::HF'FH:IGFL-“-‘-.M FILES“ORACLESGEUNMSERIDGE"

Wize Inztallation wWizard [R]

¢ Back

Cancel |

Figure 3 Destination Location for Update

4. The destination path is displayed next. This is an information only screen. No changes will be
allowed. Click Next.

15
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i'él‘ Oracle Insurance - Insbridge Rating and Underwriting 04.06.01 Setup =] |

Logon Information DRACLE

The fallovaing logon information = uged by Insbrndge. INSURANCE

Specify a user account ko be used by the application, either for running a service or for
logging onto other servers. Use the Browse button to choose uszers from pour nebwork,
For domainz, uzer names must be in the format of DORAINY ] zert ame.

Uzer Marne: |Insl:uriu:|ge Browse... |

Pazzward: | [[]I]]

Create Hew User..

Wize Inztallation wWizard [R]

Cancel |

Figure 4 Entering User Information for Insbridge

5. The next screen is the Logon Information screen. Please use the Insbridge user account information

that you set up for the initial installation. Click Next to continue.

16
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i'él‘ Oracle Insurance - Insbridge Rating and Underwriting 04.06.01 Setup =] |

Select Features DRACLE

Fleaze select which features pou would ke to ingtall. INSURANCE

Feature Description:

_ Oracle Inzsurance [nsbridge A ating and
= g -1 IIndenariting iz a ‘Web-based rating, rules, and
=l v| Oracle Bl Publisher Reports undenariting gystern.

= {g 'l Insbridge R ating & Undenwriting
i = v | RateManager

T hiz feature will be inztalled on the local hard
drive.

Thiz feature requires OKE on your hard drive. It
haz 2 of 2 subfeatures selected. The subfeat. .

Current location;
C:APROGRAK FILESYORACLEMGEUMMNSERIDGE®,

Wize Inztallation wWizard [R]
Dizk Ciozt Rezet

Cancel |

Figure 5 Selecting Features to Install

6. The next screen lists the applications to be installed. To expand the options and view details, click on
the downward arrow. All features are checked for installation. RateManager is the only one that you
will be allowed to not install. Click Next.

Options are:

e Insbridge Rating and Underwriting:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.

o RateManager:
- The default option is: Entire feature will be installed on local hard drive.
- You will be able to opt out of this option. Select Entire Feature will be unavailable.
RateManager will not be installed.

NOTE: Do not install this option for SoftRater for Windows (SoftRater Node) updates.

e IBFA:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.

e Oracle Bl Publisher:
- The default option is: Entire feature will be installed on local hard drive.
- You will not be able to opt out of this selection.

This option does not install the OBI Publisher. Only the templates required by the IBRU application will be
installed on local hard drive.
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i'él Oracle Insurance - Insbridge Rating and Underwriting 04.06.01 Setup M= Ed |

Ready to Install the Application ORACLE
Click Mest to begin installation. INSURANCE

Click the Back button to reenter the inztallation information or click Cancel to exit
the wizard.

Wize Inztallation YWizard [R]

Cancel |

Figure 6 Ready to Install

7. A Ready to Install screen is displayed. If you are ready, click Next. Otherwise click Back to check the
options you want to install. A progress screen displays your progress.

i'él Oracle Insurance - Insbridge Rating and Underwriting Setup M =] |

Updating System ORACLE

The features you selected are curently being installed.
Y v g INSURANCE

Stopping zervices...

Semvice: Insbridge Meszagelueue Service

Time remaining: 21 seconds

Wize Inztallation Wizard [R]

18



Chapter 2 — Updating an Insbridge Application

NOTE: If you receive a message that the system will need to be rebooted after the installation, STOP
THE INSTALLATION. This message means that the Insbridge Com + services are running. If
you get this message:

1. Stop the Installation.
2. Shut down the Insbridge Com + services.
3. Start the Installation over.

8. When complete, a ReadMe Information screen is displayed.

i'-E‘ Oracle Insurance - Insbridge Rating and Underwriting 04.06.01 Setup =] |
Readme Information DRACLE
Inzbridge has been successfully installed. INSURANCE
Microsoft Windows 2003/2008 Server =

A full installation of Microsoft Server 200372008 is required. The following
configuration assumes that the administrator of the server to be generally
familiar with managing a YWindows server.

Internet Information Services {l15)

The InsBridge Rating and Underwriting Systern is a web based application and
requires 115 to be installed before installation to facilitate the default web virtual
directories creations.

The subcomponents of IS needed by IBRL:

. Common Files
. Documentation
. Internet Information Services Snap-In hd

Wize Ihztallation Wizard®

< Back

Cancel |

9. Click Finish to finish the installation. The installation should complete successfully.

NOTE: Insbridge Message Services also will be stopped during the update.
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STEP 3 — STARTING INSBRIDGE SERVICES

It is also recommended that you start the Insbridge Task Manager as well. The Insbridge Task Manager is
a task queue that lists the tasks that are scheduled to be performed as well as the last time the task was
run and the status.

Insbridoe Message Service

The Insbridge Message Service is a Message Queue Listener that will route all batched messages to an assembly (process)
for execution. These processes may take resources and time to execute, Please consult with you system admin before
configuring the number of listeners per process.,

|Batd'| Rating V| | View Messages | | Edit Process Configuration |

If vou see this message, yvou have not requested a listing from the selected spoke client. Clicking
Wiew Messages will provide you with a list wiew of the first in - first out messages that are waiting to
execute.

Insbridoe Task Manager

The Insbridge Task Manager gives you the ahility to execute daily, weekly, hourly, or by the minute.

(This process may take a while to execute)

LAST RUN-DATE START-TIME STATUS

Figure 7 Insbridge Services Screen

1. InIBFA, navigate to the Services page.

2. Next to Insbridge Message Service, click Start. After a few seconds, the buttons will refresh to
indicate that the service is started.

3. Next to Insbridge Task Manager, click Start. After a few seconds, the buttons will refresh to
indicate that the service is started.
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STEP 4 — UPDATING DATABASES

Database updates can be performed in RateManager for the IBRM and IB_Client databases. This is the
recommended way to update these databases. The SoftRater database need to be updated manually on
the machine where it is located.

To update the RM and IB_Client databases, log into RateManager.

NOTE: If you need to go from an older version, such as 3.9, you will have to enter RateManager and run
the IBRM and IB_CLIENT update scripts in sequential order from there. You must be a DB Owner
to run the update scripts in RateManager.

NOTE: SoftRater update scripts must be run manually. See Manual Updates to the IBRU Databases for
more information.

Updating Databases in RateManager

The URL for RateManager will be http://INSTALLATIONSERVERNAME/RM. Where Installation server is
the server where RateManager was installed. This places you on the RateManager login screen.

If you log into RateManager and Tools is the only option, you must perform a database update.

/= Oracle Insurance Insbridge RateManager 04.06 - Windows Internet Explorg

ORACLE" Insurance Insbridge RateManager
File | Tools Help

3 Database » B Backups
% Updates

Hom

Figure 8 Tool Mandatory Update

1. Enter your username and password.

2. Navigate to the Tools=>Database->Updates.

On the DB Updates screen, the current version is highlighted and the status is Current. The
updates below the current version are grayed out. These updates cannot be run again. You will
receive an error message if you attempt to run a lower version update. Any version update above
the current version will also be grayed out but will be available for executing.

Updates have to be installed sequentially, meaning if you are on Version 03.13, you must run the
04.00 update, the 04.01 update and finally the 04.06.01 update. If you attempt to run an update
that is more than one level above the current version, you will receive an error message.
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3. The Updates tab is displayed. Select the database you want to view from the Show updates for
drop down. The database updates for your selection are listed. The last column, the Status
column, shows you which update is the Current one installed.

ORACLE Insurance Insbridge RateManager

File Tools Help

Home | DB Updates b

(&) DB Updates
J; Execute Update Script E Open Update Script E Save Update Script to File Eﬂ Refresh

Show updstes for:| IERM v |

Sonpt Release Date Database Status
v04.06.01.00 8/1/2012 IERM
wO4.06.00.00 3/1/2012 IERM
w04.05.00.00 5/1/2011 IBRM
w04.01.00.00 11/15/2010 IERM

wO4.00.0.00 3/10/2010 IERM

v03.13.0.00 12/15/2009 IERM
w02.12.0.00 4/30/2009 IER M

v032.11.0.00 11/30/2008 IER M

w03.10.0.00 B/31/2008 IBR M

w03.9.0.00 5/19/2008 IERM

w03.8.0.0 &/7/2007 IBRM

w02.7.0.00 7/28/2006 IERM

Figure 9 Available Updates

4. There are two ways to execute an update:
a. Directly in RateManager

b. In SQL Server

Directly in RateManager

This is recommended way to update a database. It is recommended that you start by selecting the update
showing Current. This assures that the database showing as Current has all possible updates.

1. Highlight the update you want to run.
2. Click EXECUTE UPDATE SCRIPT. A warning message is displayed.

3. Click OK to run the update or Cancel to return to the previous screen.
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4. Run all script in consecutive order until the 04.06.01 script is showing as current.

5. Do this for both the IBRM database and the IB_CLIENT database.

2 Confirm Update -- Webpage Dialog @

. Are you sure you want to replace the
_!_,/I current database's contents with the
. selected release script on disk?

2 Ok | & cancel |

Figure 10 Updating Scripts in RateManager

6. Click File>Reload to refresh the system

In SQL Server

This method should be performed by a database administrator. No warning message will be displayed if
you execute scripts in the wrong order. You must know the name of the databases you are updating.
Please see Manual Updates to the IBRU Database.

After you perform the database updates, to view all menu options, click File->Reload.

Updating a SoftRater for Windows Database

SoftRater for Windows utilizes a SQL Server database and requires that an update script be run against
the SQL Server database if the IBRU release is 4.5.1 or previous.

The SQL database update file is packaged in the install, located in the Databases—>SQL-> SoftRater -
IBSR->Update folder. The file name is usp_IBSR_v04.05.01.bak. Run the script against the database to
update. No other steps are needed.

This update must be run manually and is not available from RateManager like the IBRM or
IB_CLIENT databases.

If you updating from release 4.5.1, you do not need to run the update script.
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OPTIONAL STEPS

There are two optional steps that can be performed for a RateManager/IBFA update.
e Step 1: Migrate Files
e Step 2: Update Preferences

These steps may not be required, depending upon the actions you want to take.

STEP 1 — MIGRATE WORK FILES

This feature migrates work files from previous versions of RateManger to release 4.6.1. Work files are
rating, pricing, mapping and template files used in various areas of RateManager such as Impact
Analysis, Library and Testing. Migrating files allows users to access work files that were available in
previous releases of RateManager. If you do not migrate work files from previous versions, users will not
have access to them.

File Edit Yiew Favorites Tools  Help ‘ f,'

) Back ~ £ - T | - Search |W_‘f Folders ‘ E'

Address ID MMy Documents j Go

Folders ®x | Mame = Size | Type |Date Madified
[= % Local Disk () d

E] dbe1b37074575f9cdfoca08
(£ Documents and Settings
(5 Downloads
£ 1386
(L Inetpub
(£ InsbridgePackagelocation
[= (£33 Program Files
1= cmak.
1= Common Files
15 ComPlus Applications
Bl I3 InsBridge
1) ComM+
1) Framework.
=) 5ok
ICT) SoftRater
=1 I(5) webs

5o 1BFA The location of previous RateManager installations:

5 RM310
£ RMa1L
£ RM31Z

-=—— 1+ Program Files\InsBridge\Webs\RM:oo¢

where xx equals the version number

1= Mcafee
[ M3Build
1 MS¥MLE.D
@ MetMeeting
15 Online Services
B ) Oracle
Bl 1) 168U
B 5 Inshridge
£ CoM+ e
15 Framewark
I 5Dk
1) SoftRater
= I3 webs
I 1BFA The current location of RateManager:

- Program Files\Oracle\IGBU\Insbridge\Webs\RmM4
1Y

P =l 4] |
Figure 11 Location of WorkFiles
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Work files should be migrated after the initial upgrade has been run, but can be run at any time after.

Prior to migrating files, please create backup copies of the files to be migrated. This will require
access to the server were RateManager has been installed.

File Location:

The location of the files to be migrated and the exact file name will depend upon what version of
RateManager you want to migrate. There are two possible locations.

For Release 3.12 and earlier:

e File Name: WorkFiles
e Location: \Program Files\InsBridge\Webs\RMxxx\WorkFiles

Where xxx is the version number, i.e. 310, 311, 312
For Release 3.13:

e File Name: Workfiles
o Location: \Program Files\Oracle\IGBU\Insbridge\Webs\RM313\W orkfiles

Copy all work files for every version to be migrated and store in a safe location. In the unlikely event that
an error with the migration occurs, you will have backup files that you can place directly in the
RateManager (RM4) Workfiles location or restore to the previous version.

Performing the Migration in RateManager

This migration process will move rating, pricing, mapping and template files from a previous version of
RateManager to the current RateManager version. You can select the oldest version that you want to
migrate. For example, if you have been running RateManager from version 3.10, you will have the option
to select to migrate from version 3.10 and forward. You also can choose to migrate from version 3.12.

1. Select Tools=>Migrate Work Files. A separate screen will be displayed.

Tools Help
@J Manage Lines
O Audit

S Migrate Work Files

Security k
Database »
Zhange Password

Preferences

e @@
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A -- Webpage Dialog

-} Migrate Work Files

Migrate files from: b

This migration process will move Rating, Pricing, Mappings and Templates from a previous version of
RateManager that yvou selected to current RateManager, This process could take = few minutes to
complete. An alert box will appear when the process has completed.,

Miglmel @ Close |

Figure 12 Migrating Work Files

2. RateManager will determine the possible versions to migrate. Select the oldest version you want
to migrate. You do not have to select the oldest version available. You can select a newer
version. Only work files from the selected version and newer will be migrated.

Any version prior to the selected version will not have work files migrated.

3. Click Migrate.

2 Confirm -- Webpage Dialog

™ All current Rating, Pricing, Mapping and Template files will be deleted in order
_!‘_,/I to migrate the files from the previous RateManager. Do you want to
. continue?

o Ves |@ Ho |

Figure 13 Confirming a Migration
4. Say Yes to migrate. If you are unsure about the action you want to take, click No to stop the
migration process.

The migration will begin. This process could take a few minutes to complete. When all files have
been migrated, an information notice will be displayed.
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™ The process has completed,

=/

Figure 14 Successful Migration

5. Say OK to close the screen.

Ok

Verifying Migrated Files in RateManager

Migrated files are available in the same areas.

(= Oracle Insurance Insbridge RateManager 04.06 - Windows Internet Explorer

ORACLE' Insurance Insbridge RateManager

alamere U

Fle Modules Tools  Help
[ Home ] [ Testing x
[} Testing - [Private]
23 Views ~ |§ Upload Local Test File @ Run Test File x Delete Eﬁ Refresh ‘_
Include Debug Report: Include Empty Results: Output Files Fiter: | THIS YEAR ~ | SoftRater Environment Override: | Default
File Name Dzte Modified
[0 werkflovs.xml 2012-05-15T22:07:17 &)
D Workflow 3.0xml 2012-05-15T22:06:36
[0 auToLsBs.xml 2012-04-03T18:43:01
[0 AUTOLABZcml 2012-04-03T18:11:40
[0 auToLsBL.xml 2012-04-03T17:35:41
[ workflowz.xml 2012-03-16T21:45:45
[ Hoz.xml 2012-03-16T18:35:34
[ Hoi.xml 2012-03-16T17:45:58
O Ga.xml 2012-03-15T17:29:56
[ FLAUTOS.xml 2012-03-15T16:33:54
[0 FLauTOZxml 2012-03-15T16:27:44
[ FLauTOL.xml 2012-03-15T16:13:01
D Workflowl.xxml 2012-03-14T20:04:35
[0 auToi.xml 2012-03-14T18:41:23 |
= - . [ Al
Debug | File Name Run By Date Run Policies Size
[0 @& FauToz.axml Company Administrator  2012-05-15T23:18:15 1 oe &)
O =) Worlcflow2.eml Company Administrator ~ 2012-05-07T21:51:31 5 16 KB
[0 [ AUTOLABZ_ i 29 3.xml  Company Administrator  2012-04-10T20:06:00 1 6 KB
O =) AUTOLABZ.eml Company Administrator ~ 2012-04-05T21:49:53 1 & KB
0 M autoLspz.xml Company Administrator  2012-04-05T21:48:48 1 6 KB
O =) FLAUTO1 .xml Company Administrator ~ 2012-04-02T159:459:24 1 4 KB
[0 M  Testzs-zi-201ixml Company Administrator  2012-03-20T16:20:44 1 oe
O =) FLAUTO3.xml Company Administrator ~ 2012-03-15T22:21:17 1 & KB
O M ocuxml Company Administrator  2012-03-16T22:20:38 1 6 KB
O & Hozxml Company Administrater  2012-03-16T22:20:06 1 4 KB
O & workflov2.xml Company Administrator  2012-03-16T21:45:50 s 16 KB
O &  workflowi.xml Company Administrator  2012-03-15T15:34:05 4 12 KE
O M  workflowi.xml Company Administrater  2012-03-14T20:04:40 4 12 KB -
O M AuTOi.xml Company Administrator  2012-03-14T18:42:48 1 6 KB
M (=] ~ — Anen A = b/
Selected Menu Ttem: Testing

Figure 15 Verifying File Migration in RateManager
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To verify that work files from a previous version have been migrated, enter an area where these files
would be used, such as Impact Analysis or Library.

The tab will refresh with all available files. Your files from previous versions will be listed.

Verifying the File Migration in the Server

Migrated files will be moved from previous releases into the updated RM4 Workfiles location.

@ C:'Program FilesOracle’, IGBU' Insbridge' Webs'RM4' Workfiles'Mappings',Input’, Custom |- (O] x| I
File Edit M“ew Favorites Tools  Help | ;','
QBack » 3 - (T | ) search |ﬁ_“ Faldars | [l=
Address Ii] Zi\Program FilesOracle! IGELN Insbridgetwebsi R4, WorkfilesMappingst InputiCustom j Go
Falders x | Mame + | Size | Type | Date Madified |
3 18RU ;| 313.0.ut0 Training Manual Tables.xslt 1KE X5LT File 110/2011 1:13 AM
E ) R4
5 Activex
[C5) App_Themes
[ hin

() Companents
|5 Connectars
I Contrals
fil Css
125 Images
I Includes
[T Licenses
(31 Logindpps
53 Main
53 Modules
5 Seripk
fﬂ Service References
£ Utils
5 videos
[C5) Web References

Aen [

|5 ImportDataFiles
= [£3) Mappings
B (C Input
g stom
|5 Library
B 5 oukput
El Custom
|5 Pricing
[C3) Rating
T3 Releases
[T Reparts
I3 Templates I
1= sl
) #slTemplates
(£ RM313
[T Outlaok Express
|2 Reference Assemblies

e hd 1 | >
Figure 16 Verifying File Migration at Server Level

You can verify that files have been moved by looking in the
\Program Files\Oracle\IGBU\Insbridge\Webs\RM4\W orkfiles folder.
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You also can verify that previous WorkFiles have been removed by looking in the prior WorkFile location
on the server.

Workfiles only need to migrated one time.

STEP 2 — UPDATING PREFERENCES

Administrators can edit web settings at any time from the Preferences option in RateManager. Changes
will take place after the user sessions have been ended. If web settings are changed while the users are
inside the module, the change will not be visible to them. Prior to users accessing RateManager for the
first time, it is recommended that Preferences be set.

To Change Settings

1. Select Tools—>Preferences.

Tools Help

Efi Managde Lines

Ol Aodi

3 Migrate Work Files

@. SECUrity »
[ Database b

Change Password

5] Preferences

2. This will open the Preferences window. Select Web Settings.
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a Cracle Insurance Insbridge RateManager [Preferences] -- Webpage Dialog

Preferences

—I-Settings
é--User
E----Hu:nrne Page
i--.ﬂ«dministrator
E----1uﬂ.|'et:» Settings

Web Settings

Insbridge Configimi Path:  |C:\PROGRAM FILES\ORACLE\IGEU\INSERIDGE\FRAMEWORK 3

| {Secure Channel) D

| {Secure Channs=l) D

Messaging Server : |b:a|h.u-5t
SoftRater Server z ||Dca|hcﬁt
WoaorkFiles Sharz Folder |
Location:
CE Backup Share Folder -
on: |C:"\]nsbr}dge"\DB_Backup
Usa Insbridge Com+ e
Admin: -

Enforce Release Packaging: Falkbs ~

Batch Package Threads:
Minimum Login User 10

Length:

User must change o
password: { )
Show Owverride Date Mask:  True +
Allow Data Type Change: True
Inadtive Session Time Cut: IEI (hrs)

Batch Results with Newiline: Fale -

Cnline Help Server: ||D:a|hc\rsl
My Recent List:
Default Prosy Script T
son: |hﬂp.,-,- wpadwpad.dat

m

# Save | &) Close |

e

Figure 17 Preferences Settings

3. Make any necessary changes. If you do not know all the settings, you can come back and edit lat
a later time. It is recommended that you update the ONLINE HELP Server immediately.

4. When you are finished, click SAVE to update your settings.

Web Settings

Insbridge ConfigXml Path

This is the path from IBFA. This pathway must match the IBFA path. You may need to change this path if
you have changed the path in IBFA. Please contact Insbridge support for further information. It is strongly
recommended that you leave the default.

30



Chapter 3 — Optional Steps

Messaging Server

RateManager is set up to run batches on the same server that RateManager is located on. If you have an
especially large batch to run and you want to batch to a different server, you will have to change server
locations here. Unless necessary, it is strongly recommended that you leave the default.

SoftRater Server

If you need to rate on another server, you will have to change server locations here. It is strongly
recommended that you leave the default.

Backup Share Folder Location

When you make backups of the RateManager database, you can specify the location of the backup file. If
the location is local, you will use a local path. If the location is not local, you must be a disk admin to
change.

If the database is on a remote server, a share is needed for the backup location. The Insbridge user must
have write access to this location as well.

Use Insbridge Com + Admin

This setting must always be true. If there is a conflict, please contact Oracle Insurance support.

Enforce Release Packaging

When set to False, a release is not required in order for users to create a SoftRater (full) package. False
is the default setting.

If set to True, a release is required in order for a SoftRater (full) package to be created. If a user wants to
create a SoftRater (full) package in the Program Explorer module, a release must be created in the
Releases area first. This release must have the program added to it and be unlocked. When the user
creates the SoftRater package in Program Explorer, they will have the option to select the Release they
want this package to be placed into. If there is no release, or no release that contains that program and is
unlocked, then the user will be able to do RateManager (local) packages only.

Batch Package Threads

RateManager allows you to change how many threads are used. Threading enables a process to finish
faster by splitting the process into smaller processes that run quasi-simultaneously. On multiprocessor
systems, using multiple threads enables the operating system to assign the threads to different
processors.

In addition, the Framework Administrator also enables you to change the administrator email address for
each client. When a process fails, an email will be sent to the person who initiated the process, as well as
to the administrator email addresses listed for the client of that process.

NOTE: Before changing the number of threads, you should consult with your system
administrator. Setting the number too high can result in poor performance or even a
system crash. If you are unsure of how many threads to use, set the number to 1. For
single processor systems, Oracle Insurance recommends a maximum of 2 threads.
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Minimum Login User ID Length

This is the minimum number of characters required for a user ID.

User must change password

This where you set the number of days before a user is required to change his/her password. This setting
will only be active when you elect to have users change their password on the user setup screen.

Show Override Date Mask

If enabled, a date mask for ‘Date’ data types will be displayed when importing a table. If not enabled, this
field will not be visible.

Allow Data Type Change

The type of data associated with a parameter. RateManager supports three (decimal, integer and string)
data types for variables and inputs and a fourth (date) for inputs and result variables only.

Setting this option to True will allow RateManager users change the data type of a variable or input.
Setting this option to False will not allow users to change data types.

Inactive Session Time Out

This is the amount of time that a user sits inactive before being automatically logged out of the system.

Batch Results with New Line

Allows batch results to go to a new line instead of forming one continuous string. A True setting will place
a carriage return between result files. A False setting will result in one continuous string without a break.

Online Help Server

Online help is installed with RateManager. This setting should be the server name where RateManager
currently resides. Either a server name or an IP address can be entered here. If needed, you can change
the name of the server. For example, if the machine name is not the same as the host name, you may
need to change the name in order for online help to function.

Change Control

If change control is on, it will be mandatory for users to enter a change control entry and justification to
any element or program when it is revisioned. If change control is off, the option will not be presented.
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UPGRADING TO A NEW MACHINE

If you are upgrading RateManager/IBFA from any previous release AND moving to a different machine
you will need to perform these steps. These steps will allow any packages loaded to the old machine to
be loaded and used by the new machine. If you do not perform these steps, old packages may not rate
properly or even be available to users.

NOTE: These steps need to be done only when you are migrating your RateManager/IBFA instance
from an old machine to a new machine.

o Step 1: Install RateManager/IBFA

o Step 2: Export the Insbridge Registry Key from the old Machine

e Step 3: Import the registry key from the old machine to the new machine
e Step 4: Copy the Insbridge XML file from the old machine.

e Step 5: Paste the Insbridge XML file in the new machine.

e Step 6: Finish the Installation

e Step 7: Run the Oracle Client — Optional

e Step 8: Manually Migrate Workfiles

After these steps, your RateManager/IBFA should be ready for use.

Step 1: Install RateManager/IBFA

A RateManager/IBFA upgrade that involves moving to a new machine is considered a new install. Please
follow the instructions for installing RateManager/IBFA in the RateManager Installation Guide.

STOP At Step 6 — Configuring Insbridge Framework Administrator.

Do not create a subscriber or environments.

Step 2: Export the Insbridge Registry Key

The Insbridge registry key located in HKEY_LOCAL_MACHINE->SOFTWARE~>Insbridge is used to
store all information for proper encryption of the SoftRater Packages (SRPs).

When RateManager/IBFA is re-installed on a new server, a new registry key will be created. The new
registry key will not match the registry key associated with any packages that have been created on the
old machine. In order to load packages to the new machine, you will need to restore the previous registry
key.
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1. On the old machine, enter Registry Editor. Run->regedt32.

2. Select the Insbridge key: HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge.
3. Rightclick and select Export.

4. Select a storage location for the file and Save.

5. Close out of Registry Editor.

Step 3: Importing the Registry Key

The old registry key needs to be imported in to the new machine.
1. Save the Exported Registry Key to a location you can easily access.
2. Double click the Exported Registry Key. The key will be loaded.

3. Store the Exported Registry Key in a safe location.

Step 4: Copy the Insbridge. XML File

You can copy and paste the Insbridge XML file from the old machine to the new machine. This will allow
the environments and subscriber created in the old machine to be populated in the new machine.

NOTE: If you want to re-enter or re-create your environments, you can skip Step 4 and Step 5. After you
import the registry key, you will need to continue the RateManager/IBFA installation at Step 6 —
Configuring Insbridge Framework Administrator.

File Location:

The location of the Insbridge. XML file to be copied will depend upon what version of RateManager the old
machine is running. There are two possible locations.

For Release 3.12 and earlier:
e File Name: InsBridge.XML
o Location: D:\ProgramFiles\InsBridge\Framework\2.0.2\InsBridge.Xml.
OR C:\Program Files\Oracle\Insbridge\Framework\2.0.0\insbridge.Xml

For Release 3.13 and later:

e File Name: InsBridge.XML
e Location: C:\Program Files\Oracle\IGBU\Insbridge\Framework\3.5.0\Insbridge.Xml

Copy the Insbridge. XML file to a location you can easily access.

NOTE: If you are changing databases, you can copy and paste the Insbridge XML file, however you will
need to update your environments with the new database information.
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Step 5: Paste the Insbridge. XML File

Before pasting the Insbridge. XML file into the new location, make a copy of the blank Insbridge. XML file
and store in a safe location. In the unlikely event that an error occurs, you will have a backup file that you
can use.
The Insbridge. XML file in the New Machine is located:
C:\Program Files\Oracle\IGBU\Inshridge\Framework\3.5.0\Insbridge.Xml

1. Make a copy of the blank Insbridge.XML file on the new machine and store in a safe location.

2. Paste the Insbridge. XML file from the old machine in to the new machine in the same location.

3. Open an Internet Explorer web browser either remotely on the local IBRU web server and browse
to IBFA location on the new machine: http://SERVERNAME/ibfa/

4. Subscribers and Environments should be available in IBFA on the new machine. Verify your
entries.

Step 6: Complete the RateManager/IBFA Installation

Complete the instructions for installing RateManager/IBFA. Please see the RateManager Installation
Guide for detailed instructions.

Continue at Step 7 — Verifying the Component Services. You will need to complete the rest of the
installation.

Step 7: Run the Oracle Client — Optional

This step is optional. You will need to run the Oracle Client if you are utilizing a Java SoftRater, i.e.
SoftRater for WebLogic, SoftRater for WebSphere or SoftRater for JBoss. The Oracle Client is located in
the Oracle Cloud Delivery package. For instructions on running the Oracle Client, please see the
corresponding SoftRater Installation Guide, i.e. SoftRater for WebLogic Installation Guide, SoftRater for
WebSphere Installation Guide or SoftRater for JBoss Installation Guide.

If you are running 64-bit, please make sure you use the 64-bit client.

Step 8: Manually Migrate Workfiles

After the installation has been completed, you will need to migrate workfiles. Follow the instructions for
Manually Migrating Workfiles, see page 24.

The RateManager system is ready for use.

NOTE: If users experience any difficulties with migrated packages, please verify that the database
usernames and passwords are entered for any SoftRater environment.
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IMPORTING REGISTRY KEY AFTER INSTALLATION

The registry key can be imported at any time after the initial RateManager/IBFA install and subscriber
creation. If the registry key needs to be imported after you have completed the installation and set up your
SoftRater environments, you will need to re-enter Database Username and Passwords for the SoftRater
Environments.

This procedure is only required if you have configured your environments. If you have not configured
your environments, you should not have to re-enter usernames and passwords for your environments.

Prior to starting, IBFA should be up and running on the new machine.

Step 1: Export the Insbridge Registry Key

The Insbridge registry key located in HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge is used to
store all information for proper encryption of the SoftRater Packages (SRPs).

When RateManager/IBFA is re-installed on a new server, a new registry key will be created. The new
registry key will not match the registry key associated with any packages that have been created on the
old machine. In order to load packages to the new machine, you will need to restore the previous registry
key.

1. On the old machine, enter Registry Editor. Run->regedt32.

2. Select the Insbridge key: HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge.

3. Right click and select Export.

4. Select a storage location for the file and Save.

5. Close out of Registry Editor.

Step 2: Importing the Registry Key

The old registry key needs to be imported in to the new machine.
1. Save the Exported Registry Key to a location you can easily access.
2. Double click the Exported Registry Key. The key will be loaded.

3. Store the Exported Registry Key in a safe location.

Step 3: Re-enter Username and Password

1. Enter the new IBFA instance.
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2. Browse to SoftRater=>Explorer=>Subscriber name.
3. Select the Environments link under the Configuration header on the left hand side.

4. You will notice that the database username and password entries will be blank. Please re-enter
the username and password. Test connections for any SoftRater environments.

5. Save your entries and close out of environments.

Upgrading the Database Machine

If you are upgrading your database machine, the new database information will need to be entered in
IBFA->Environments.
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MANUAL UPDATES TO THE IBRU DATABASES

The preferred method of updating the IBRM and IB_CLIENT databases is to go into RateManager. If the
administrator has DB User privileges and is the DB Owner of the database as well as the disk
administrator, database updates can be done on the Tools=>Database->Updates tab. If these privileges
are not in place, an error message will be displayed. See Step 4 — Updating Databases for more
information.

NOTE: If you need to go from an older version, such as 03.13, it is strongly recommended that you enter
RateManager and run the 04.00, 04.01, 04.05, 04.06, and 04.06.01 update scripts successively
from there. Failure to run scripts in order may result in errors.

To manually update a SQL Server database, you will be required to save off each update and run them in
sequential order in SQL Server. A DBA or a person with the proper permissions will need to apply the
database updates in SQL Server using Query Analyzer.

1. First, you will need to get the scripts you need from RateManager.

2. In RateManager, highlight the update you need. Begin with the version that is listed as “current”.
If you are going from a much lower version of RateManager, you will have to save multiple files.

3. Click Save Update Script to File. Your computers dialog box is displayed. Save the file to a
location of your choice. For IBRM scripts, it is recommended that you rename the file to
usp_IBRM_R(version number).sql. For example the Release 4.6.1 update would be:
usp_IBRM_RO04.06.01.sql. For IB_CLIENT scripts, it is recommended that you rename the file to
usp_IB_CLIENT_RO(version number).sgl. For example the Release 4.6.1 update would be:
usp_IB_CLIENT_R04.06.01.sq|.

4. Verify that you have saved all the necessary scripts from “current” to release 04.06.01. You must
save off update scripts for both the IBRM and the IB_CLIENT databases.

5. Next, enter SQL Server.

NOTE: If you do not have database permissions, you will not be able to perform the following database
queries.

NOTE: When using Database Engine Query, the SQL scripts must run on each individual database.

6. Begin with the current version of either the IBRM database or the IB_CLIENT database. Open
Query Analyzer.

7. Open up the DB script updates from the download file. You can open in any program you want,
such as Notepad. Begin with the “current” script. For example, if you are going from release 03.13
to 04.06.01, 3.13 should be “current”. Open 3.13 first.
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Figure 18 Updating Database

8. Select the database you want to update. In SQL Server Management Studio, create a new
Database Engine Query, File>New—>Database Engine Query.

9. Copy the first update from Notepad and paste onto the query screen.

10. Click Execute. The script will execute. Any messages will be displayed in the lower portion of the
screen. You must run the updates in sequential order. Run each update until you run the
04.06.01 update.

11. When you have finished updating one database, update the remaining database. Make sure you
do both the IBRM and IB_CLIENT databases.

12. After the scripts have been run, return to RateManager. Click Refresh Listing. The status should
show current and the full RateManager menu should be displayed. The updates are now properly
applied and users can log back in to the system.

NOTE: You can view the update script in RateManager. Select the update you want to view. Click Open

Update Script. Thehe update script will be displayed in a separate screen.

2 IBRU : v04.06.01.00 -- Webpage Dialog

GO

GO

——5ET THE DATE FOEMAT TO &N EXPECTED FOEMAT TC SETUF THE SCHEMA INFUIS
5ET DATEFORMAT mdy

if not exists
= 'TYPES_SCHEMA' and COLUMN NAME =

if not exi=stcs
= 'TYPES_SCHEMA' and COLUMN NAME =

[zelect * from INFORMATICN SCHEMA.COLUMNS where TAELE MNAME
'TEMPLATE ID')
LLTER TRELE TYPES SCHEMA ADD TEMPLATE ID INT NULL

(gelect * from INFORMATICN SCHEMA.COLUMNS where TAELE MNAME
B 'TEMPLATE VERSICHN')
LLTER TRELE TYPES SCHEMAR ADD TEMPLATE VERSICN INT NULL

Figure 19 Script Viewer
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Updating a SoftRater for Windows Database

SoftRater for Windows utilizes a SQL Server database and requires that an update script be run against
the SQL Server database if the IBRU release is 4.5.1 or previous.

The SQL database update file is packaged in the install, located in the Databases-> SQL-> SoftRater -
IBSR->Update folder. The file name is usp_IBSR_v04.05.01.bak. Run the script against the database to
update. No other steps are needed.

This update must be run manually and is not available from RateManager like the IBRM or
IB_CLIENT databases.

If you updating from release 4.5.1, you do not need to run the update script.
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UPGRADING SOFTRATER FOR JAVA

How you upgrade SoftRater for Java will depend upon what IBRU release you are starting from:

e Upgrading from Oracle Insurance Insbridge Rating and Underwriting Release 3.13.4 or previous
to release 4.6.1 requires that the previous .EAR and config files be removed. The new .EAR file
can then be deployed and the new config file must be implemented.

o If you are upgrading from release 3.13.5 or later, you need to redeploy the .EAR file only. You do
not need to redeploy the config file.

e You will need to run an update script against the database you are utilizing.

e If you are upgrading from release 3.12 or previous you should check for SOAP changes. Updated
WSDL documents will need to be incorporated into any client calling application that
communicates with SoftRater. If upgrades are done to the SoftRater for Java engines without
updating the calling applications, the calling application will fail.

NOTE: UPGRADE YOUR TEST ENVIRONMENT PRIOR TO PRODUCTION. Validate in test prior to
implementing in production.

Steps to Upgrade SoftRater for Java:

Every upgrade requires:

1. Update the application server. Please follow the instruction for the release your application
server is currently running.

e For Release 3.13.4 and Prior, delete the .EAR file and config file.

o For Release 3.13.5 and Later, delete the .EAR file only.

1. Update the associated database. All database updates should be performed by your DBA or
qualified system administrator. This takes the SoftRater databases to release 4.6.1.

NOTE: Updates are performed manually on the database server.

Additional Steps to Upgrade SoftRater for Java:

You will need to run this step if you are currently running release 3.12 or previous and
incorporating a calling application:

e Update the WSDL documents.

This will allow your calling application to function in the upgraded SoftRater.
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SOFTRATER UPDATES

There are three SoftRater for Java engines:
e SoftRater for WebLogic
o SoftRater for WebSphere
o SoftRater for JBoss

The upgrade procedures to the application are similar and the upgrade procedure for the associated
databases is the same.

UPGRADE NOTICE

This notice is for customers currently running a SoftRater for Java engine release 3.12 or previous. This
includes:

o SoftRater for WebLogic

o SoftRater for WebSphere

o SoftRater for JBoss
Necessary updates have been made to the SoftRater for Java engines:

o SoftRater for WebSphere has been updated to SOAP version 1.1.

o SoftRater for WebLogic has been updated to SOAP version 1.2.

o SoftRater for JBoss has been updated to SOAP version 1.2.
These changes mean that the WSDLs for the SoftRater for Java engines have been modified. Updated
WSDL documents will need to be incorporated into any client calling application that communicates with
SoftRater. If upgrades are done to the SoftRater for Java engines without updating the calling
applications, the calling application will fail.
Please update a test environment prior to deploying to production. Install the .EAR file in a test

environment to obtain the WSDL. Update your calling application and then test again. When testing is
complete, you can upgrade your other environments.

NOTE: Customers running a Windows only environment, without a Java component, will not be affected.

These updates are for the SoftRater for Java engines only.

42



Chapter 6— SoftRater Updates

UPGRADING WEBLOGIC

SoftRater for WebLogic can be upgraded any time after the IBRU system.

Upgrading from Release 3.13.4 or Previous

This method removes the previous .EAR and config files. The configuration information needs to be re-
entered in IBSS and validated in IBFA.

If you are using SQL Server, please see the Preserving Environments for SQL Server Upgrade
information. The Preserving Environments for SQL Server Upgrade information allows you to keep your
existing environments by editing the config file.

1. Locate the configuration folder used in the previous SoftRater for WebLogic installation. The
configuration folder would have been parked in a location on the WebLogic server. For example:

e InaWindows environment, C:\Insbridge\config
e Ina Linux environment, home/ Insbridge/config
This same folder should be used for the update.

2. Locate the current Insbridge.net.softraterconfig.xml file within the configuration folder and
make a back-up copy. The configuration information will need to be re-entered in IBSS. The
updated config file will not contain this information. This information cannot be directly imported
but a copy of the original file may be helpful when re-entering.

3. Enter WebLogic and stop the WebLogic Service.

4. Delete the old IBSS_WL.EAR file in WebLogic.

5. Start the WebLogic Service.

6. Return to the configuration folder and delete the previous config file, the previous .EAR file and
the previous .jar file. You can leave the log file.

7. Inthe configuration folder, unzip and place the contents from the new SoftRater for WebLogic
Release 4.6.1 zip file inside. There will be an XML file, a .JAR file and an .EAR file.

e oOjsp.jar
e IBSS_WL.ear
e Insbridge.net.softraterconfig.xml
8. Verify that the system property is in the WebLogic Server. If you have placed the new files in the
same location as the previous files, the information can remain the same. If you have changed

location, you will need to update the file.

9. Return to WebLogic. Install the required library. For help with installing the library and .EAR files,
please see the SoftRater for WebLogic Installation Guide.

10. Install the new .EAR file.
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11. Enter IBSS. You will need to re-enter the config information.

12. Verify your entry in IBFA.

13. If necessary, obtain any WSDL information from IBSS and update any calling application.

14. Test your configuration and updated calling applications before deploying to production.

Upgrading from Release 3.13.5 or Later

This method removes the previous .EAR but leaves the config files. The configuration information will
remain and does not need to be re-entered in IBSS.

1.

10.

11.

12.

Locate the configuration folder used in the previous SoftRater for WebLogic installation. The
configuration folder would have been parked in a location on the WebLogic server. For example:

¢ InaWindows environment, C:\Insbridge\config
e Ina Linux environment, home/ Insbridge/config
This same folder should be used for the update.
Enter WebLogic and stop the WebLogic Service.
Delete the old IBSS_WL.EAR file in WebLogic.
Start the WebLogic Service.

Return to the configuration folder and delete the previous .EAR file. You can leave the .jar file and
the log files. Leave the Insbridge.net.softraterconfig.xml file as well.

Unzip the SoftRater for WebLogic zip file. There will be an XML file, a .JAR file and an .EAR file.
e oOjsp.jar —you will not need this file
e IBSS WoL.ear
o Insbridge.net.softraterconfig.xml — you will not need this file

Place the .EAR file from the new SoftRater for WebLogic Release 4.6.1 zip file inside the
configuration folder. You do not need the .jar file or the .xml file.

Verify that the system property is in the WebLogic Server. If you have placed the new files in the
same location as the previous files, the information can remain the same. If you have changed
location, you will need to update the file.

Return to WebLogic.

Install the new .EAR file.

Enter IBSS. You will not need to re-enter the config information. All config information should be
present.

Test your configuration before deploying to production.

44



Chapter 6— SoftRater Updates

UPGRADING WEBSPHERE

SoftRater for WebSphere can be upgraded any time after the IBRU system.

Upgrading from Release 3.13.4 or Previous

This method will remove the previous .EAR and config file. The configuration information will need to be
re-entered in IBSS and validated in IBFA.

If you are using SQL Server, please see the Preserving Environments for SQL Server Upgrade
information. The Preserving Environments for SQL Server Upgrade information will allow you to keep
your existing environments by editing the config file.

1.

8.

9.

Locate the configuration folder used in the previous SoftRater for WebSphere installation. The
configuration folder would have been parked in a location on the WebSphere server. For
example:

e In aWindows environment, C:\Insbridge\config

e Ina Linux environment, home/ Insbridge/config
This same folder should be used for the update.
Locate the current Insbridge.net.softraterconfig.xml file within the configuration folder and
make a back-up copy. The configuration information will need to be re-entered in IBSS. The
updated config file will not contain this information. This information cannot be directly imported
but a copy of the original file may be helpful when re-entering.
Enter WebSphere and stop the WebSphere Service.
Delete the old IBSS_WL.EAR file in WebSphere.
Start the WebSphere Service.

Return to the configuration folder and delete the previous config file, and the previous .EAR file.
You can leave the log file.

In the configuration folder, unzip and place the contents from the new SoftRater for WebSphere
Release 4.6.1 zip file inside. There will be an XML file, and two .EAR files.

e IBSS WL _v7.ear
e IBSS_WS vé6l.ear
e Insbridge.net.softraterconfig.xml
Return to WebSphere. Install the new .EAR file for the version of WebSphere you are running.

Enter IBSS. You will need to re-enter the config information.

10. If necessary, obtain any WSDL information from IBSS and update any calling application.

11. Verify you entry in IBFA.
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12. If necessary, obtain any WSDL information from IBSS and update any calling application.

13. Test your configuration and updated calling applications before deploying to production.

Upgrading from Release 3.13.5 or Later

This method removes the previous .EAR but leaves the config files. The configuration information will
remain and does not need to be re-entered in IBSS.

1. Locate the configuration folder used in the previous SoftRater for WebSphere installation. The
configuration folder would have been parked in a location on the WebSphere server. For
example:

¢ In aWindows environment, C:\Insbridge\config
e Ina Linux environment, home/ Insbridge/config
This same folder should be used for the update.

2. Enter WebSphere and stop the WebSphere Service.

3. Delete the old IBSS_WL.EAR file in WebSphere.

4. Start the WebSphere Service.

5. Return to the configuration folder and delete the previous .EAR file. You can leave the
Insbridge.net.softraterconfig.xml file and the log file.

6. Inthe configuration folder, unzip and place the contents from the new SoftRater for WebSphere
Release 4.6.1 zip file inside. There will be an XML file, and two .EAR files.

e IBSS WL_v7.ear

e IBSS_WS vé6l.ear

e Insbridge.net.softraterconfig.xml —you will not need this file
7. Return to WebSphere. Install the new .EAR file.

8. Enter IBSS. You will not need to re-enter the config information. All config information should be
present.

9. Test your configuration before deploying to production.
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UPGRADING JBOSS

SoftRater for JBoss can be upgraded any time after the IBRU system.

Upgrading from Release 3.13.4 or Previous

This method removes the previous .EAR and config file. The configuration information needs to be re-
entered in IBSS and validated in IBFA.

If you are using SQL Server, please see the Preserving Environments for SQL Server Upgrade
information. The Preserving Environments for SQL Server Upgrade information allows you to keep your
existing environments by editing the config file.

1.

8.

9.

Locate the configuration folder used in the previous SoftRater for JBoss installation. The
configuration folder would have been parked in a location on the JBoss server. For example:

e InaWindows environment, C:\Insbridge\config

e Ina Linux environment, /Users/Administrator/Desktop/config
This same folder should be used for the update.
Locate the current Insbridge.net.softraterconfig.xml file within the configuration folder and
make a back-up copy. The configuration information will need to be re-entered in IBSS. The
updated config file will not contain this information. This information cannot be directly imported
but a copy of the original file may be helpful when re-entering.

Enter JBoss and stop the JBoss Service.

Delete the old .EAR file from the JBoss deployment directory. ie:
<JBOSS_Installation_Home>/server/SR_Server/deploy/

Return to the configuration folder and delete the previous config file. Go to
“<JBoss_Installation_Home>/SR_Server/conf” folder and look the “jndi.properties” file. The
configuration file information should be located here.

Return to JBoss. Install the new .EAR file. Copy the IBSS_JB.ear file to the
<JBOSS_HOME>/standalone/deployments location.

Start the JBoss Service.
Enter IBSS. You will need to re-enter the config information.

If necessary, obtain any WSDL information from IBSS and update any calling application.

10. Verify your entry in IBFA.

11. If necessary, obtain any WSDL information from IBSS and update any calling application.

12. Test your configuration and updated calling applications before deploying to production.
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Upgrading from Release 3.13.5 or Later

This method will remove the previous .EAR config file.

This method removes the previous .EAR but leaves the config files. The configuration information will
remain and does not need to be re-entered in IBSS.

1. Locate the configuration folder used in the previous SoftRater for JBoss installation. The
configuration folder would have been parked in a location on the JBoss server. For example:

e InaWindows environment, C:\Insbridge\config
e InaLinux environment, /Users/Administrator/Desktop/config
This same folder should be used for the update.
2. Enter JBoss and stop the JBoss Service.

3. Delete the old .EAR file from the JBoss deployment directory. ie:
<JBOSS Installation_Home>/server/SR_Server/deploy/

4. Install the new .EAR file. Copy the IBSS_JB.ear file to the
<JBOSS_HOME>/standalone/deployments location.

5. Start the JBoss Service.

6. Enter IBSS. You will not need to re-enter the config information. All config information should be
present.

7. Test your configuration before deploying to production.

Common Errors

If you experience any deployment issues, look for a deploy fail file in the deployments folder. Delete the
deploy fail file and try again.

You also can re-name the .ear file to IBSS_JB.ear.
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Upgrading for 3.13.4 or Previous: Preserving Environments for a SQL Server Upgrade

NOTE: You do not need to do perform this action if you are running release 3.13.5, or later. These steps
are not necessary if you do not want to keep your existing environments.

If you are utilizing SQL Server and want to keep your current Environment settings, you will need to edit
the insbridge.net.softraterconfig.xml file.

1. Deploy the new .EAR file.

2. Open the insbridge.net.softraterconfig.xml. The insbridge.net.softraterconfig.xml file will be

located in the folder you setup when you initially installed SoftRater for WebLogic. For example,
C:\Insbridge\config.

3. Make a back-up copy of this file.
4. In the insbridge.net.softraterconfig.xml file, find this section:

<jdbcDriver provider="1" name="SQLSERVER">
<jdbcDriverClassName>com.microsoft.jdbc.sqglserver.SQLServerDriver</jdbcDriverClassName>
<jdbcUrlPrefix>jdbc:microsoft:sqlserver://</jdbcUrlPrefix>
<jdbcFetchSize>25</jdbcFetchSize>

</jdbcDriver>

And replace it with this:

<jdbcDriver provider="1" name="SQLSERVER">
<jdbcDriverClassName>com.microsoft.sqlserver.jdbc.SQLServerDriver</jdbcDriverClassName>
<jdbcUrlPrefix>jdbc:sqlserver://</jdbcUrlPrefix>
<jdbcFetchSize>25</jdbcFetchSize>

</jdbcDriver>

5. Restart the Application Server.

49



UPDATING SOFTRATER FOR JAVA DATABASES

After the application servers have been updated, you will need to update the database servers. All
database updates for SoftRater engines must be performed manually.

SQL Server Update

SoftRater for Java utilizing a SQL Server database requires an update script be run against the SQL
Server database if the IBRU release is 4.5.1 or previous.

The SQL database update file is packaged in the install, located in the Databases-> SQL-> SoftRater -
IBSR->Update folder. The file name is usp_IBSR_v04.05.01.bak. Run the script against the database to
update. No other steps are needed.

If you updating from release 4.5.1, you do not need to run the update script.

Oracle Database Update

SoftRater for Java utilizing an Oracle database requires an update script be run against the Oracle
database if the IBRU release is 4.5.0 or previous.

The Oracle database update file is packaged in the install, located in the Databases—>Oracle—> SoftRater -
IBSR->Update folder. The file name is usp_IBSR_v04.05.00.oracle. Run the script against the database
to update. No other steps are needed.

If you updating from release 4.5.0, you do not need to run the update script
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Support

CONTACTING SUPPORT

If you need assistance with an Oracle Insurance Insbridge Rating and Underwriting System product,
please log a Service Request using My Oracle Support at https://support.oracle.com/.

Address any additional inquiries to:

Oracle Corporation
World Headquarters
500 Oracle Parkway
Begvxood Shores, CA 94065

Worldwide Inquiries:
Phone: +1.650.506.7000
Fax: +1.650.506.7200
oracle.com

TTY ACCESS TO ORACLE SUPPORT SERVICES

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the United
States of America 24 hours a day, seven days a week. For TTY support, call 800.446.2398.
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